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(W) Multisim {5 A & 4 $

1.1.1 Hk

NI Multisim 14. 0 & 3 [& [ Z 4% A FR 2~ 7] (National Instruments, N & 75 [ LA
Windows R 48 Ky 5 aili, B A 52 B2 BB AL SPICE {5 B4R L & — A~ T AR 2y 1
/807 W B R TR RS, 2 E K KR 3¢ B 8 R 2 w6 (Interactive Image
Technologies, IIT)F 20 th 4 80 4FfC AR H 1 Electronic Workbench(EWDB) i1 T+ 2% i .

Multisim % T Analog Devices %9 /52 3 R 7= RS2 i 19, 2235 22000 4R HY
s T T N SE R B R 8 R rh BEAT e A . AR A R A A& b OB I UK L
AR DDA R SRR A T PR BT R DA AL B L R 2L

Multisim 7% T 8050 3R eREUE 5 & B 8% L e R AL R B 48 55 22 Fh 45t 5
FAL A, R 5 8 0 o T 5

Multisim &4 % T B TAE 807 S0 20 B RS 20 H755 20 R Il AR ) SPICE
G3 BT A3 AT 45 SR AT e R B Y DU R DR AR RN AT B, D LR s R OR B IR 1 B
DL KCRT R A A e 1 i DR 5 B FH P O 5 A0 b 3 A F B A TR

555 R 51 2B # ] LU Multisim $E 4705 B, A S8 5250 3% 31 52 50 2 Y
AU A 0 BR A e i SE AT, BT LA Multisim 5 BLSEEL, A ARBES S RELE T
W R Multisim (AR CHERAE RPN BEFEAT 41, LI 2 S 30 i 22

11,2 FEARHR(E

245 NI Multisim 14. 0 # )5, /£ Windows % 1 F & % “ I > fr A #2 5> NI
Multisim 14. 07, AT LAE FANE 1. 1. 1 FroR B9 A . b SR o0 & b A A (iR 24 i iz
AT B3R 20 AR BRI SCUE 4% 7)) R BARS Ao T A L T 2 A e T HAS, DL KR
ARR P T AR R T HAS, RRas AR W B O, 220 5 T RA A i 41X
ar TEAE . JRCHE N B R R RS

PATR 6 3 2 1 A5 D Re XA T TR A

1. Multisim #) 3% % #

Multisim BZERRASWE 1. 1.1 iR 12 > SRR, LS a2 .

(1) U (File) : A& T B ORAE AT EN G HRAE

(2) i (Ediv : 2RS4 F 2 T76 B B vk b B v, 0 el 8O0 858 B AR 1Y)
S BT U) R A — R

(3) M (View) : %3 a4 ] % &4 A T HAL B B R R DL KO A % 7 11 A 45
AR

(4) 251l (Place) : 1% 3% 5 iy 4 3 H 223 1 o 6 I8 B 30 & JC 28 00 1 i R SUAR 5§
e

(5) Pz il a (MCUD %3 iy 2 2 6l A Bz il i 85 1 1y A o rL B O EL4R A

2



B bedE AR SCReE T ALES SEaps oY R VRS fl TrLE

Be i fje P WOV Fosimm Bugger fok Bepeds ptes mhaics —

D ek @0 LETI EHEAE @ P m—— __.-,.n-"-"b- 27

e - TR RS 10 LY S

(IO
Dy i =
Dag s m
B e

= ST e

:l llQ'll-l-- PN R PR
E z—--':_l'— J et e[ e | ‘-."_ .". /,f'
i R T P E"-:JEIE Sk ILESETI {i 3% i:ur%.

1.1.1 Multisim £& O

(6) fij H (Simulate) : 1% 3% 8 iy & & i 5 3 45 1k 05 5 LA e 0 B BT L 2 480 B 55

(7) R4 (Transfer) 323 B a4 5 BORE L D7 F045 51T 1 O 4% 26 21 H A o
I RE .

(8) T.H.(Tools): Z3E a4l 244t 555 A 3L ef % | I8 D% 2% 25 4% Fh H FH el % 10 bl ol
BT RE . LA KT TC A R AL B 00 S B B AR

(9) et (Reports) : 33 i A T A2 WU P B 75 18 584> 70 28 140 A7 filt 7 B0 12 b
A A B VR S B

(10) #EI(Options) : ZFKH A M T2 RS 88 S Hny € DL TAE R
WHE.

(11) % H (Window) : %3 5oy m B g OGRS 24N i A7 H A

(12) # B (Help) : I AT A 250 5 i 4 8 0 B I 32080 H s 385 | 45 e 040 BT 75
3 Bl

2. Multisim % =T B A

(1) bpife T HA% (Standard) « 40558 2 AT I ARAF AT ED I ORGSO AR

(2) ETHF(Main) : "]XF P45 RMEEE BT T HAR Bl 2k THAZ o defF 1%
S HEAT 75 B G ) 4 A

(3) Joastf T EA: (Components) : # FJCas 1 1Y HREERS

(4 METH A (View) : M T B AR H N A 2 AR TR 46/ AR T3 2 i
PEYO 43 oL 2 BRIIRE .

1-F
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(5) i E T HA~ (Simulation) . W] X5 {5 BT 5 3 /45 187 B 45 /K527 1484

(6) g% T HA (Instruments) : W5 ECF T IR REUGE 5 & AE S DR RE 22 Fp
AR P (6 R AT O 3K R LA RS

3. & T A 4 (Design Toolbox)

Bt THAR R TR B R,

4, B % 2 (Workspace)

H, 1A 102 DT R KA 2S AL B B TAE X,

5. # 3 & H# 42 (SpreadSheet View)

Bs RAR A T W 07 Bz A7 45 R A G w5 L B SO rh BT oo R R SR

6. kA

ARSFETE DU NC AR, W7s S wif B4R N 28 DL S BUbs i i A B AR DG AR L

1.1.3 Multisim Bl & HLE% [

FH Multisim 75 55347 52 56 H P& L 55— 20 2 B 2 vl 8% 15T 3% BLX Multisim 44a] 8]
L AR T A A

Multisim 14. 0 J3 315 » 806 A sh 8 S — A% 4 Designl #9723 1L SCHE . P B
T HAT R B4 File> New-> blank and recent-> create 3¢ 57 & — N2 14 | B& Sc 4, S 4
BRNAr 2, P T HE B 44 . 808 B D R — 2 1S,

1. A ELEAM

AT SR BAr A 4 ] (Place)-> TG % 4 (Component) , # P4 Corl + W, & 3L 40
BLL 102 Fr R XETERE . AR i BRES AU 43 1 22 20 A7 i AE B8 e b . an ik % 1kQ s Y
T 1E BRI AY B2 E (Master Database) T, fE2H %1 32 (Group) " 3 3 3L K JT #3 1F
2H (Basic) , £ &2 5131 3 (Family) H 3% # #5 BHL (RESISTOR) , #£ # [1] Component — = H1 1%
PEPRAE 1k, o] 7E XA AE i A 1k BEAT PRI R BOA A Q. 7240 Symbol 21
Szt aR bRk . I C L R OK #2441, 308 A B oo a8 14 iZ G HE 25
F 3 OCHT 11 2 H i TAE X, Jo e fF AR SR 3l 76 v 3% T A DX B i BT oo A%
VGl RN R E VA VARl o (1 27, & S wir I =B v v o o (U 1 R P SN A
Detail report, UNAN{EFE I 4% 78 76 WA~ 2 vh, m] 5 Search #4718 &, 5 J5 8 54 b 4
1. 1. 3 7R A HE . 78 Component —42 gy AJTas {44 F AT R . WA TE R TH1F
A4 R AT ] « AN R T AR R

A b T R G s T AR - He A S T TR e

2. LEMMBRMESEKE

(1) JoasfFiEadE . s Joae i, Yoo (8 8 Bl s 0 6 R 45 HE I, SR iZ ot ae 1k
ELRE . ARG L BT UL N R T AR O R BRAE R BE R 5 Windows AH R, 1 AL R
Bk,

(2) ToaRPFRYIESE . A Irif R AR R ST ae fF B b e S N s 1. 1. 4 P ik i,



B 1.1.2 EETHGIEE

] Advanced search using “user fiekds®

B 1.1.3 #ERTHEIEE

Flip horizontally /8 /K- Bi%% , Flip vertically /8 3 H #1%% . Rotate 90° clockwise F /N
T B} £ e % L Rotate 90° counter clockwise &7 138 B £F e 4% . v AR 4 A () P £ gk 30E 45
X R

Flip horzontally Al +d
Flips yertiealy Ala¥
“A Rotate 50° dockgise Crisk

e Rotate 907 courter clockwise Carl s Shift 4R
B 1.1.4 THERGREREXTR
(3) TS HEE . il sk o, ol LLIAT 32 B 4 Edit> Properties, L AJ
PR FERE Corl+ M, 3 H 2 00E % TAEX oo 28, s b an i 1. 1.5 Frzs XF 3G AE X oo
S EGE TR E .
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1

[Label | Duaptay | Vot |Fauit | Prm | vanant | ser fekds |

Remstance &) 1k - @
Tedkes i o - %
Companent type:

teygeerink;

Aaddifonal SFITE smalaion marsmebers

| g afre [ig= B rr)
| Temperatore oeffloert (TCE: |0
| Temperatre confficent (TCZ: [0

|Mormirall lemperatre (THOM): |27

Lyt s bbngs
Promri [ e footgrm.. |
Harutactiaen: [

agiace... | o] [omen ] Crew |

B1.1.5 THREGESEIEEINEIE

B MR IEHEAD & 7 AR 43 5 bR IR (LabeD) | %78 (Display) B (Value)
W (Fault) 5] (Pins) . 31 & 28 & (Variant) M A F i {5 B (User fields) . H 9 & H
B LR B AN .

(1) Fri(LabeD) : H P AME 2T #4814 19 1 R (LabeD) # 45 (RefDes) , 4 5 — i H
G H BN AT AT B 38 L H B LR AIE S S I —

(2) A (Value) : H P AT E B TT#F R BUE R/ A5 22 55 S8

3. LB E R

(1) LT FOCHRFE 3h B T a8 51 INAL 25 By 307 B 09 -+ e bs s adi 51
F& O BB B R CE D AL % R LS Bt SR A . N A
FUOEL AL E P B LA I R 2 B 5, 2 B T A RS AL B A5 R S 2k
A, Al RFESE Cerl+-Shift+ W fDEAR ALy + 7 BDE , Bl T 45 2008 1 30 5
BRI 5] S R s S R RS

(2) FLMMER: Bz R4, S sl AT M Ak W7 18 4/ J7 HE B Z 5 2 8
e, #2 Delete #MI R F25 .

(3) B4 4551 R AT 44 Edit> Properties—> sheet visibility-> net names—>
show all, /R P4 45 .

() T E RS A 9 S S A i S SO R AR R B T AR X e —
AT /NP 10106 2 TR . TR 101L6 1 RS0 E T Sk AL D 32 AR
I RS, MFRIZAL T4 GEE , AT E PR ] (Place)>45 (Junction) ¥ H 5 45, iU



TP 228 XA RIAT
R3
=l
i (1

1.1.6 BETEASZTXAEER

1.1.4 Multisim JE 5 EALZZ 0918 H

NI Multisim 14. 0 Hr4@ 4k 1 21 R B 2 6 43 Ar vb s T AY R SUL0CAS . 3k 26 1 #U14X
L FE BT 7 & (Multimeter) | B 805 5 & /£ %% (Function Generator) , I 3 i}
(Wattmeter) \ Al 38 78 % 7% (Oscilloscope) . PUil i 7= 3 %% (Four Channel Oscilloscope) |
4% 78 AL (Bode Plotter) , #1l R 11 £ 4% (Frequency Counter) . 715 5 & 4 2% (Word
Generator) 32 #84r H1{X (Logic Analyzer) .32 35 #{L (Logic Converter) . IV 45 ¥ 43 #71{X
(IV-Analysis) . 5 B & 43 #71¢ (Distortion Analyzer) . #1573 #7 {X (Spectrum Analyzer) ,
W 2% 43 H14L (Network Analyzer) LR A5 5 & 4 %8 (Agilent Function Generator) , % £
177 FH % (Agilent Multimeter) . % 18 78 I %% (Agilent Oscilloscope) ., Z& T8 7~ % #%
(Teltronix Oscilloscope) . SZ A Il f& £ 41 ( Dynamic Measurement Probe) . Labview R F£4Y
5 VISR (Circuit Probe) . T IR AS 45 95 Je () 5B 43 A48 247 #T SR A4

1. H #1455 X £ % (Function Generator)

PRALR 5 R AR AT LUBR B IE 5% 0 . = MDA 35 5 . i Function Generator T
BIbn 2K 11,7 Z230 8 XFGL EAR . X7 i B AR & T & 1k 4 35 0 3 AE Qn 18] 1. 1. 7
AR

1.1.7 APESEEREREEERENIEIE

7 Ja A G 8 T AE TR L A S RO B R

(1) P (Waveforms) . i i #81E 5% =Mk k.

(2) {55 3% W (Signal options) ,

> 5 5 M (Frequency) : HBEFEIEE D 0. 001pHz~1000THz, BRIAE N 1Hz,
» 45 (Duty cycle) . HEEEEE R 1%~99% , BRIAE K 50% .

af ol e — -]

L'

#
-

i

i

=E



REiEit. . ®#

BESEHETRTENE

> el (Amplitude) 72 A AF 5 AR KAH , k£ 0. 001pV~1000TV, EIAE

10V,
* IR E (Offset) . ¥ B ESIRGESSNEH S, HEREE R —999~999kV, 2k
NMEH 0V,

(3) ¥ FTH/ T RERE (Set Rise/Fall Time) : AU T8I e i, % &7 (551
S0 2 o N 11 £ e 8 T S I DR BRI 5T N O R G| I SR AN I 2 AN = - SR AL
i nsec.,psec.msec, BRIAHE (Default) SN 10nsec,

Rise Fal Time: (1.00000e 009 ~ 50000000 1) (i)
10} e oo ]

nnml

1.1.8 55 EF/ T EEEIEIE

(4) Common: &7~y 345 1 v
» 55+ F Common ¥, B HES M EWREEFES . WES THESALESNSE

E.
» {55 4% — Fl Common ¥, 278 i tH 155 8 FOMAEAR 5 IR 5% 75 5 R BRI A
E.

A5 T R — i, 5 5 IR A 4 TS 5 82+ 1 Common %ig B B R 4%

2. i@ i 7 )% % (Oscilloscope)

X3 T8 7 Y A FH > D R I s 4 A5 5 i 5T 0 L R AR S8, B ili Scope i
PB4 20 an 1l 1. 1.9 1 7R RGH B 7R A% XSCL, BUl 2% B bR o J TF T M g 8 %o 145 AE 4n
1.1.10 i,

1.1.9 JBERKEFER

BL1.1.9 W A LB S8 IE [+ 78 35 53— Ui o 7 D #4512 1 oy R 3 R 2 b
H BRI HE D . Ext Trig i Mt &5 S5 At . B 11,10 W& SEM BN T .

1) Timebase X

Timebase X FHEATH {5 S WS EX & .

» Scale : R/n X Rl 1w b AREA 20 BEACKR MBS E] G 1£s~1000Ts,

¥ X pos. (Div) : 79 5% i (] B o (1982 45 007 B . W FI Y —5~ 15V,

B Y/ T XAl Rmh o) 2088, Y s ALB 88 RS 5 0 . e 58 i R gk Ay

=il



LLASCIE R HE A (AR

FIHE R e ff

gty (N
- ML 2 ] 1 | '*Mm':‘ Al 2
S 1 PR VT ]Fuﬁﬂi Bl
| Liﬁ!FLIL»'LhJI'!Jh’"" .' i 4
E I Time: Channel_A Channel B | |
LTI WPt -2.500V D000 ¥ +— R IEIEH \m
e EEl 0.0008 -2.500V 0.000 ¥ =—¥IR2K )28
T2T1 || 0.000s 0.000 ¥ 0.000 ¥ -— R fLin St m Ext.
Timebase: Channel A Channel B Trigger :
- Scale: 100 us/Orv Scale; 5 V/Div Scale: 5 ¥[Ow ege: (@] [a) 5 e
pos. D)z 0 Yposwk B “-']‘mﬂfh] -1 leve: o
e 0 B /@@q—a@ ® I_FJ&-;J@H

1\ ‘\ T A R
‘\ﬁm BVl

.'I | I L.ﬁtlllh i
' i

Uy

Bk o I,

% :mm

1

P T R () Rl s W

|
X4t SI0E . YRS RA - BiliiH |

|
-4 R e

\
Y

SRl Y e

XU E A (Div) ISR

Rl i = R A AU Y

Y i L {7

E1.1.10 FHEEBMHETIFIE
»B/A: Xhizs ABEES,Y HE R BEEGS, 2080 & B 5w E

FR A3 RN AR A
» A/B: 5§ B/A .
> Add: X B R iR ZIEE Y B B8 ALB B IE RS
2) Channel A.B X
Channel A.B XIIEHAH] , AR A 44 Channel A X,
> Scale: /R Y fill & —4% (Div) (i B R {H L JE [ & 1V ~1000TV,
¥ Y pos. (Div): AT HEE Y S HAHE,
> AC: ARG 5 AMG S I8 E H i AU 53 b R S ok
0 $EH B A 50 M
> DC: H USRI EIE A2 o3 5 AV o B i R
3) Trigger X
» Edge: $UYfil & , AT e b fih () 50N BT fih 4 (R

» Level: filt & a7, F P o] 8755 il & Ha 5P RN

» Type: & fi & )7 X A Single CHL ik o fith %) . Normal (— & ik ' fil &) . Auto (A
Sk, — Mkt A Bl % .

> A BB A A GEIEEL Bl E 5 AAG S AR R D X bl 1 il (S

» Ext: &bﬁwi

3. v id i 7 K & (Four Channel Oscilloscope)

VO3 7S P s A 11011 R T LATR) I X 4 B AF S R AT WS R i . BRI AE XT3

1-F

o
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BESEHETRTEXSE mEiEd. (FA. KiE

LA AR5 AT 08 L WG AN B I A P32 e A TE S 5 M

rn @el Ceme A Camdl  Cuardl  Chamd D e—y
o = O e 25007 244V ; .
MM e 2%00v 2432V L
T2T1 | 1000w 0000 ¥ BI04 @0
Teneaer hannd_A - Triager
Scaler 100 us{Dw Scale: 5 WiDw i Edge: i) [h]  Ext

- D B :
pesDw): O Ypes.[el L6 # Leve: o v

S - c

() (48 ] a8 alele@l © @ (g normal | Ao | pane]aa) <

11,11 i@ E RSB EREINEIE

VU 38 7 Y0 A 0 TR AR A R L ) BE RN R B 00 B R A SR AR — B0, AN (A 1 AN i
PIe . 7E Channel A XATHA —A 4 P45 TF G HE£0 o HE £1LH8 ST BN B 45 18] A DKL
PrA% B HESH b 7 50T A0 B RE A 2 B L @S AN AR AR BB RIS 1) AH R Y R A
TE 4 FRAR R O o BIAT X2 HEAT 2 H0CE L iR e R L T DD 2 O E TE AT S
B E .

4. W4 B =M (Bode Plotter)

A T s ASCT P R DN 4 R I 73 P, B SR 8 ) AR 1 S AR L 2R DL T SR B Y
RN . 7F Multisim 473 T2 A= 5 K FR 81 Bode Plotter J& it & £ HL % 4]
L HNIET 1. 112 B R R A P e

SETTYIERE
e

IN ou
SR

1.1.12 HEBFE RN
Wity XBP1 El A fm B 1. 1. 13 i @ g X 3G HE . B 4 ot 17, 43 31 7%
B BRI A (D) MY IEME VIn+, ik Vin— . % i (Oud) I IEH VOut+ . i VOut
— 5 PR R R AN B s 1A X

' Bedde Plotes XEP1 e

e

]
Honzoetal vertical

e[ w | [dep][ i

F 1 @t | po -
il | § 20 =
Controls

| Revese | Seve Set.

+ in * Ot =

11,13 5 E T B E 48 XS 1E

W R R AL B 2 S ER RV AN T
(1) Mode X : ¥ 8 2271 5t 4 s A IR,
¥ Hii Magnitude 2588 7 08 A5 47 PR Hh & .



» B Phase BE8E 7R AR M 4 i 45

(2) Horizontal IX . 35 % i FE E =AU X 4l 20 B 0 5 7R J7 XA 2438 1]

» Log: B A FRAR ROF 6 B2 B2 W

» Lin: B8 A8 BRbR ROH 2P 20 B o

» 1. Initial, 3B B HRMR BOABAALY MHz, By AHE ] {473 B,

» F: Final, i &2 L%, 500 GHz, B 67 HE W] [ 47 5 2le, 28 1k i3 0 20 K
THIE W

(3) Vertical X . 35 & P47 B R AR Y 3l 20 B %) 5 7 o SR 465 [

» Log: W4 W AFURR P I 40 By Log 4215 . Y Mlibs RZIBEl 20Log(V (), /V,)dB,

» Lin: Y flibs ROTZeM: 20 5 B,

(4) Controls X ;

¥ Reverse: AT Y B/aRE DR SEit, il AR WML,

» Save: K45 R L) BOD kg X AA 6 . ORAF 5 FHIC 35 4 4% AT F AT DLW % 31 ) 5
) A a5 B

3 Set: BT Setting dialog XHEHE , A 7E 1~1000 ¥ £EHCT . % B F1HE 1 43 H¢
R, A R R BBy AR B AT B ) G . BRIAE R 100,

5. R iE 5 H AL (Spectrum Analyzer)

WS S AT SO T 20 M 455 BRSO S G A o A (B R B AN A 1. 1. 14

JIe s A3 3 M AR AR . PR TN S A » T A ik 4 i

Xl J T I A 4 0 A L AN BT 1. 1. 15 o,

I @ |
1| 1I|h.f|l|hl| (31

I__.____.

1.1.14 SR o 47 (LB #R

[ setsan |[Zemsmn.]( Flsmen |
Frequency Amghtade
nter (8 [ dem | [
Spari: 0 [ Ha Range: 2 VfOre
Start: | 2 [@z || Refjn | &
Center: 2 GHz Resokition freq:
Erad: | 2 | Py 15.625 Mz
st Gt | (Reverse )| sron refer. |[Csetun
Enput Trigger

1.1.15 g o B HEHREXTIEE

=1-E

e
allf n= Do
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(1) Span control [X . &£ MM %5 & X,

¥ Set span: i Wl i Frequency X & .

¥ Zero span: Y H Frequency X[ Center £21& %€ 1) DRI E ,

» Full span: & RHEHM . H#W %R 0~41GHz,

(2) Frequency X . ¥ 8 4 50 R 95 F

¥ Span: B E IR ATE R,

> Start: U R R GG (E

# Center: WE MR O,

» End: 3E FA#FORM L.

(3) Amplitude X :

> dB: YAAFREA 3 D (dB)

> dBm: AR LA 53 DT Z AR (dBm)

> Lin: YNALBRZ0 B B AR T2 MR .

» Range: B¢ & IR — 4 10 IR 18 .

» Ref: WEZSHIRIE.

(4) Resolution freq X . & BRI HER . AR IE 0T IX 4055 6

(5) Start: Ji SIS AT

(6) Stop: 15 IESHE A HTAL .

(7) Reverse: MAEFFHTF S B,

(8) Settings: BEE Ml &I -5 fh % 07 2. H 7 3L ANET 1. 1. 16 Prs XS HE.,

¥ Trigger source: W & fit & R, 7] Internal (PN &R filt & JF) 8% External (4p&F fith
KID .

¥ Trigger mode: WE fit & 3. A1 Continuous (% 2L it & 7 2) B Single (FLIX
fith 77 70

3 Threshold volt: filt & Hi = B { .

% FFT points: B & @ BI040 S8, BRUE SN 1024, ] €8 1024 MR5EL,

fﬁ'

Trgges source
& Jrternal Exterral

Trigges maode:
& Canilrudnn | e

1.1.16 %% EITIEE



1.1.5 Multisim 5 B {55 Wil

A A9 K VF Z2 AT Multisim SEAT I 50 7 09 SE 560 . 55 05035 53 Fr AR G 9 05 1 92 56
BEW T Multisim $2 £55 09 B B% 20 BT 2 RE AL mT LA 1. 1. 4 540 28 8805 20 B A AT 53
Br o A K BARA 28 1] Multisim o) fd B 534 2 68 53 A7 J5 0145 5 00038 1 5 12

T2 41 (Fourier Analysis) 75 152 70 Hr JE IS 5 990 SRR AR 79 — Fh Bl O 1, it 2
K T 1) R TE 525 S B i — R AN B IE % AR K LA S R A S . R
5 @A LR N

f@)=A,+ A coswr +A,cos2wt + **+ + B sinwt + B,sin2wt + -
Ho A, AEGESHERD E; A cos wt + B, sin ot IS4 A, cosnwt + B, sin nwt
>R n WA LA, B, B YO REL

Multisim Hv #9853 A 75k S FE A3 0 F g vl 18 35— 355 1 g 0 BT X R, 60 B 5
SR TR B B0 5 A A L S A, SRS R AR R A AR L 3 BT A S Y U A L R )
AP ot . PRI A AT (R LI 3 A R 0 20T 5 1 49 0 X R B v o R AT 46 L 3 A
71 5. I L — Bk H i v 1% S U Il TR ) AR R Ry R, A TE HL B R A LA SR
PR AT DU BE AT SE (X SRR 2 gL E . BN . A5 6. 5kHz #1 8. SkHz P32 {5
U5 U HEARU 0. 5kHz, 2 0. 5kHz 19 13 YIE B 6. 5kHz, 17 Wil HE 8. SkHz.

N RA I 1L 1L 17 B s 0 R B v ek A T A A AR T AR B9 O AR T D
Multisim 8% 73 Br 77 35 0 A8 HL o3 B 45841 20 %

PGl
EE R
e 3
| ]
1
R1 .
o =

1.1.17 77 B 503 53 4 it e g

I

(RSN RN

i PR B 9 R B A S R AR 2R 0+ 2 common S, B B S SN Vp-p=1V, Offset=
OV %Ny 1kHz, 25 th>h 5020, FUBH R1 2 1kQ, TE B W0 200000 B 45 M v . U0 7 356 S i
4> options (3% i )-> sheet properties CH, I & J& ¥) , 76 “ 5 1 B & PE 7 %5 iF fE o 3% 3
“NetName (W 4% 24 FR) "L T, 5] £ “ show all (£ #F 887, X AF B 5 Pof 2 5o
BT

2. TR 2

PUATE B 4y A Simulate (fff B )-> Analysis and simulation (3% £ {5 & 7> #1 5)—>
Fourier Analysis (B 5387) , 4T AH I A A B 238 7 35 8 X 35 A L an & 1. 1. 18 Firi .

(130 |
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Fourier Anabysis = RN -
|| | Anavss parameters | ousgut | Analhyus options | Summery |
Sampireg opons
Frequency resolution {(undamental kequency): 1000 Hr Eawmate |
ey of harmarara: 4
Bl e For sarmpling {TSTOR): 0.001 L ——
Ecit banserd analysss. |
Foemitn
Doaply phass Dmsglay: Chart and Graph -
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